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Dear Customer:

Thank you for choosing PC-Planner, Jeppesen 
Marine’s navigational planning tool. PC-Planner 
brings the power of your chart plotter into the 
comfort of your own home!

This handbook provides a simple introduction to 
PC-Planner and offers some advice on installation, 
basic functionality and troubleshooting.

Once the software is installed, further detailed 
instructions on the information provided within 
this handbook can be found in the User Manual, 
which can be accessed with the <F1> key while in 
PC-Planner.

We welcome your feedback as we continue to grow 
and improve the PC-Planner program.

Should you have any questions or concerns not 
addressed in this handbook or in the User Manual, 
please do not hesitate to contact our Technical 
Support Department at 1.800.424.2627.

Thank you, and happy planning!

Jeppesen Marine 
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PC-Planner

Package Contents

Your PC-Planner package includes the following:

Orange Multimedia Reader•	
CD (software and driver installation files)•	
USB cable •	
Activation Code•	
Handbook•	

If purchased, the 
following accessory 
may also be included:

Optional memory  •	
 card (for transferring  
 data to chart plotter)

Sample. Your reader may 
vary in appearance.
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2. ABOUT PC-PLANNER

2.1 What is PC-Planner? 

PC-Planner is a route planner that turns your PC into a virtual chart plotter, less 
GPS. It allows you to view your chart data, create and change routes, accurately 
measure distances, add and edit waypoints and marks and access the Port 
Services database. By using your chart card, PC-Planner will mirror the detail 
you see in your chart plotter. You’ll gain access to all the planning data that 
C-Map charts offer, including: Coastal Navigation Data, Depth Contour Data, 
Spot Soundings, Port Information, Marina Information and Tide Data. Most can 
transfer these trip plans to a C-Map memory card, plug the card into their chart 
plotter and load these routes on the spot. 

2.2 Memory Cards

Nearly all of the C-Map compatible chart plotters on the market have the 
capability to transfer data to and from PC-Planner via a memory card. The list 
of chart plotters compatible with our memory card is ever growing. If you are 
interested in knowing if your chart plotter is compatible with the memory card, 
please contact our Customer Care Department or Technical Support Team at 
1.800.424.2627.

2.3 Demo Mode

PC-Planner can operate in two modes: either the DEMO Mode trial version or 
the fully registered version. If you have purchased the full version and are in 
demo mode, please read section 5.1 “Getting Out of Demo Mode.”
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3. INSTALLATION

3.1 Requirements

· Windows 95/98, ME, 2000, XP or Vista
· 16MB RAM
· 50MB free Hard Disk space
· Video Resolution: 800x600 or higher
· Video Colors: 65536 (high-color, 16bits)
· Available USB port (versus a remote hub)
· Memory Card (optional for transferring data to chart plotter)

3.2 How to Install

DO NOT plug the PC-Planner Card Reader into a USB port until you are 
instructed to do so.
 

The installation wizard will guide you through the installation process and offer 
default choices. It is suggested that you read these instructions carefully in order 
to ensure a successful installation.

Close all open Windows/Programs.1. 
Insert PC-Planner CD (AutoRun should start. If not, browse to your CD drive  2. 

 and run the file PCPNTAUTORUN.EXE).
Select preferred language.3. 
Select “Install PC-Planner.”4. 
IMPORTANT! Choose only the Reader Driver that corresponds to your   5. 

 particular reader (refer to the Driver Table on page 12 to be sure). Turn the  
 unwanted drivers OFF by clicking the respective boxes, then select INSTALL.  
 Do NOT connect to the Internet, even if prompted to do so. 

Select NEXT, YES and/or FINISH when prompted. 6. 

READ THESE INSTRUCTIONS 
BEFORE PROCEEDING WITH THE 

INSTALLATION!!
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3.3 Activating PC-Planner 

Once installation of PC-Planner software, reader driver and 
demo charts is complete:

If you have not already been prompted to do so, then make sure Reader is  •	
 plugged into a USB port.  The ‘Found New Hardware’ wizard may appear.   
 Continue through installation. Once complete...

 Open PC-Planner by clicking on the PC-Planner icon.1. 

 Your registration code is printed on the back of your Installation        2. 
 CD sleeve (on a sticker).  Enter this code into the “Enter Registration  
 Code” box, replacing the zeros. If you encounter problems with your  
 registration code, generate a new code AT http://pcplannernt.c-map.it  
 or by calling our Technical Support Department at 1.800.424.2627.

If the registration code is accepted, the World Map will be displayed (usually at 
the 0° LAT / 0° LON position off the coast of Africa).  Local chart data is only 
viewable once a chart card is inserted into the USB reader.

 
3.4 Registering on the Support Site

It is suggested that you register your PC-Planner to receive important 
notifications regarding updated software releases, updated drivers and any other 
modifications to PC-Planner... and it’s no cost to you. You will also have access 
to the SelectMarks database of wrecks, hangs, obstructions and reefs. These are 
user point files you can download and upload into your PC-Planner. Registration 
is now done on the PC-Planner website at http://pcplannernt.c-map.it and follow 
the link to “Register Here.”
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4. USING PC-PLANNER

4.1 Setup

PC-Planner has several settings that will 
allow you to customize your display to 
show as little or as much chart detail as 
possible.  There are also settings for personal 
preference on lat/lon display, language and 
others. PC-Planner defaults to suggested 
settings.  To change the settings, go to 
View > Settings from the main PC-Planner screen.  This brings up a window 
with several tabs of options (see diagram, right).  Detailed setting info can be 
accessed in PC-Planner using your F1 key > Contents > PC-Planner Options.  
However, PC-Planner is built to be compatible with the entire C-Map family 
of chart plotters.  Some chart plotters require different formats for waypoints, 
tracks and routes, and as such, PC-Planner has a variety of emulation modes 
available. It is recommended that you set the correct Plotter Emulation as listed 
below. 

Plotter Emulations

Furuno Navnet1 - For all Furuno NavNet1 plotters. The USBFP Reader 
is required in order to work.  Furuno Navnet 1 mode has 7 different icons 
for Marks and 16 different icons for Waypoints/Routes, each of which can be 
assigned one of 7 different colors.  Marks CANNOT have a name or description; 
only Waypoints can.

Furuno Navnet2 - For all Furuno NavNet2 plotters.  The USBMM (USBMM 
2.0) reader and an SD-card are required. Furuno Navnet 2 mode has 7 different 
icons for Marks and 16 different icons for Waypoints/Routes.  Each of these 
can be assigned one of 7 different colors.  Marks CANNOT have a name or 
description; only Waypoints can.
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Plotter Emulations continued...

Furuno GP-7000 - For the Furuno GP-7000.  The USBMM (USBMM 2.0) 
reader and an SD-card are required.  Furuno GP-7000 mode has 16 different 
icons that can be used for Marks and Routes, each of which can be assigned 1 of 
8 different colors.
 
Navman 8xxx & Northstar M Series - For the Navman 8-inch and 
Northstar M Series plotters.  The USBMM (USBMM 2.0) reader and an 
SD-card are required. These modes have 30 different icons for Marks and 48 for 
Routes.
 
Fish-12 SD - For plotters that read cartography from C-card and use an 
SD-card for user data (e.g. Fish-12). The USBMM (USBMM 2.0) reader and 
both C-card and SD-card are required for full functionality. Fish-12 SD mode has 
16 different icons that can use 1 of 16 colors for Marks and Routes.

Generic - For all C-Map compatible plotters that do not fall into the 
categories above. Generic mode has 16 different icons that can use 1 of 16 
colors for Marks and Routes. 
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4.2 PC-Planner Toolbar 

This toolbar is displayed at the top of the screen on your PC when PC-Planner is 
running.

Each of the Icons in the toolbar selects a different operation. Left-clicking the 
relevant icon selects that mode and displays the icon in light gray to indicate it is 
active. PC-Planner will stay in that mode until another icon is selected or the ESC 
key is pressed to quit a particular mode. In this situation the program defaults 
back to the “Pan Chart” mode.  Toolbar functions can also be accessed by right-
clicking on the map in any mode except Zoom. 

File Manager

Print

NMEA Transfer Enable

Pan Chart

Zoom In or Zoom Out

Info Chart

A-B Distance Measure

Add User Point

Delete User Point

Move User Point

Edit Route

Create Route

Route Checking On/Off

Perspective View On/Off

Chart Boundaries On/Off

Animated NavAids On/Off

C-Weather Download

Chart Rotation
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4.3 Keyboard Shortcuts

PC-Planner Function Keyboard Key

Help/User Manual F1 Key

File Manager Control F

User Points List Control U

Routes List Control R

Tracks List Control T

Print Control P

Pan Chart Arrow Keys

Zoom IN I/D Key, Mouse Wheel Up

Zoom OUT O/U Key, Mouse Wheel Down

Chart Boundaries ON 9

Chart Boundaries OFF 0

Brightness Page Up/Page Down

4.4 File Manager

File Manager is the interface for transferring data between PC-Planner and 
memory cards for use in your chart plotter. It is similar to Windows Explorer,   
and may require some “getting used to” until you become familiar with the 
layout and moving data around.  For detailed information on using memory 
cards, please refer to section 9 of the User Manual (this manual can be   
accessed using the F1 key on your keyboard).  Also, for troubleshooting File 
Manager, please refer to section 5.2 on page 14 of this handbook.
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5. TROUBLESHOOTING

5.1 Getting out of Demo Mode

DEMO mode is the result of either the card reader not being properly inserted 
directly into an available USB port on your PC, or the drivers not being properly 
installed. Three different scenarios that may be the cause of  DEMO mode are 
listed below and on the following page. One or all may apply...

#1.  Is the “Card Reader” connected directly to the PC?
PC-Planner will not work if connected to a “remote hub.” It must be installed  •	

 directly into a USB port. If not, reconnect, wait a moment and then try to   
 reopen the program.

Is the program open more than once? Check to make sure there is only one  •	
 version of PC-Planner running at once.  The easiest way to check is to hit   
 CTRL + ALT + DELETE; check the task manager for PC-Planner applications;  
 end them and then try to reopen the program.

Is the card inserted? If the card is inserted, please remove it, close the   •	
 application and then restart the PC-Planner.

#2.  Are the correct Drivers installed?
There are several card readers available, and thus many choices for drivers. Only 
one driver should be installed as it corresponds to your reader, or the program 
will open in “Demo Mode.”
 

DRIVER TABLE

Reader Driver 
(as depicted during 

Installation)

Physical Description 
of Reader

Corresponding Driver 
(as listed in Add/Remove 

programs)

USB C-card Reader Gray 2-slot reader USB C-card Reader

FP-card Reader Gray 1-slot USB FP-card Reader

Multimedia Reader Orange 3-slot USB Multimedia Reader

Multimedia Reader
USB 2.0

Orange 3-slot with 
serial#706-xxxx or higher

Multimedia Reader
USB 2.0
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Getting out of “Demo Mode” continued… 

1.  Open the Add/Remove programs and make sure only the corresponding  
 driver is installed. The only driver file that should be installed is the one  
 you are using. If more than one of the drivers is installed, then remove the  
 other drivers that don't match the card reader being used; unplug the   
 device and reconnect it.

OR… 

2.  If the driver you are using is NOT listed under the Add/Remove programs,  
 then remove all other drivers and close the Add/Remove programs window.  
 Reinsert the install CD. During this Installation it is very important that you  
 install only the driver being used (see “Driver Option List” on page 12). 

#3.  Are the Drivers installed correctly?
Right-click on 1. My Computer > Properties > Hardware > Device Manager 
Look for a yellow exclamation mark within the list of Drivers.         (The list  2. 

 may be flashing and you may hear a “dong” noise.  Do not be alarmed).  
 Make sure the installation CD is in the CD drive.

Double-click the yellow mark and select “Re-install” Driver.  After the device  3. 
 is uninstalled, click the top menu option “Action” and then “scan for   
 hardware changes.” (Do not connect to the Internet at this time).

Continue through prompts by selecting “Next” or “OK.” A “Digital Signing  4. 
 Warning” will come up; Please continue through this. (Program may loop;  
 please continue through until completed). Close Device Manager and   
 reopen PC-Planner. 



14

5.2 File Manager

File Manager is the dialog box used for transferring data from the PC-Planner 
to memory cards and vice-versa. It is important to understand File Manager, as 
it is the easiest way to transfer the data in your PC-Planner to your chart plotter 
Please refer to the diagram below for all column names. The column names are 
displayed as such: “PC-PLANNER MEMORY.”

Q.  How do I format a Memory Card?
A.  IMPORTANT! Formatting your Memory Card will erase all route/waypoint  
 data on the card. In File Manager, while you have the memory card inserted  
 and selected in “TARGET DRIVES,” right-click on “LIST OF FILES IN TARGET  
 DRIVE” and the option to ‘Format User Card’ or ‘Initialize User Points File’  
 appears. Click on the box that appears.
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Q.  How do I transfer data to the user card?
A.  In File Manager, you will need to select the Memory Card in “TARGET   
 DRIVES” and “PC-PLANNER MEMORY” on the opposite side. Highlight   
 the file you would like to transfer in “OBJECTS IN PC-PLANNER MEMORY”  
 and click on the red arrow pointing to “LIST OF FILES IN TARGET DRIVE”  
 column. This will send the files you have selected to the Memory Card. 

Q.  Can I backup my route/waypoint information to my Computer? 
A.  Yes. First, create a folder in your hard drive. Then follow the steps in the  
 previous question, but select the newly created folder (you will need to  
 browse to it) in “TARGET DRIVES” instead of the Memory Card.

Q.  In the File Manager there is a Floppy Disk option. When I try to save to a  
 floppy disk, I get an error message. Why?
A.  The Floppy Disk option in File Manager is provided ONLY for owners of the  
 SI-TEX Trawlplot and Fishplot 12 chart plotters. These chart plotters do not  
 use memory cards, but use specially formatted floppy disks available   
 directly from SI-TEX.

Q.  In File Manager, I am getting a “Device Not Present” error.  Why?
A.  Make sure you have your Memory Card inserted (and in the correct slot)  
 when transferring data. 

5.3 Operational

Q.  Why is my Registration Code not valid?
A.   Double-check that you have entered the correct registration code. If you  
 have updated your software, then the old registration code will not   
 work. You can obtain a NEW registration code by visiting the support site:  
 http://pcplanner.c-map.it or by contacting our Technical Support Department  
 at 1.800.424.2627.
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Q.  Must I have a MAX card to get MAX features on my PC-Planner?
A.   No. Perspective View, Flashing NavAids and Flexi-Zoom will all work in   
 PC-Planner, regardless of what type card you are using (NT, NT+ or MAX).  
 Currents, photos and other MAX data content will ONLY be available with  
 MAX cards.

Q.  Can I use my SD chart card as a Memory Card? 
A.   Yes. SD (secure digital) cards have the ability to also hold route and   
 waypoint information. Erasing/formatting the route and waypoint data from  
 your SD-card will not erase the chart information.

Q.  What does the Route Checking feature do?
A.   The Route Check is a safety feature that will scan through all chart layers  
 to check a proposed route you are creating. Using the settings found in  
 VIEW > SETTINGS, you can customize the Route Check to search for   
 anything from rocks to insufficient depth or obstructions. PC-Planner   
 will warn you if the Route Check finds any hazards and asks if you would  
 like to continue saving the route.

Q. How do I edit a Route/Waypoint? 
A. The User Points List, found under User Data > User Points List, contains all  
 of the information for all marks and waypoints stored in PC-Planner   
 memory.  From the User Points List it is possible to add, find, delete and  
 create routes. Detailed information on editing user data can be found in  
 your User Manual under Contents > User Data. 

Q.  Is there a character limit when creating routes/waypoints? 
A.   In PC-Planner there is a 15-character limit on the NAME and 31-character  
 limit on DESCRIPTION. However, certain chart plotters have different   
 requirements for length of name and descriptions if you intend to upload  
 the data to the chart plotter.
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5.4  Advanced User Tips

Q. How much user data can PC-Planner hold? 
A.   As of version 11.04, PC-Planner only has a 3,000-point capacity. Future  
 versions will expand upon this to allow for larger file handling.

Q.  Can I do anything with the user data outside of PC-Planner?
A.   Yes. You can save the data to your hard drive in XML format. PC-Planner  
 has a ConvertXML.EXE program that will convert your XML format into  
 a CSV (comma-separated value) file (found in PC-Planner under 
 TOOLS > Convert XML). The CSV file can be opened in a spreadsheet or  
 word processing program, allowing you to edit and manipulate the data on  
 a global scale, rather than individually in PC-Planner.  XML files can then  
 be transferred via Email or other storage devices to friends and family.

Q.  Can I print with PC-Planner?
A.   You can print in black and white directly through the PC-Planner. If you  
 prefer to print in color, you'll need to use the “Save Screen As…” function  
 under the “File” menu. This will save a color screen shot into a PNG file that  
 can be opened in a web browser. You can then print from the web browser,  
 or you can do a variety of other things with this file (mark it up, draw on it,  
 etc.), with optional design software.
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5.5 C-Weather

Q.  What is C-Weather? 
A.   PC-Planner now has the capability to download weather information to  
 your desktop. The weather data includes temperature, wind speed and   
 direction, wave height and direction, weather conditions (sunny, clear,   
 cloudy, so on), humidity and visibility.  A four-day window covering a 
 3 degree x 3 degree area will be downloaded. 

Q.  Is C-Weather available worldwide? 
A.   Yes. As of version 11.0.4, C-Weather is available worldwide.  To download  
 the latest version of PC-Planner, please visit our support site at   
 http://pcplanner.c-map.it. 

Q.  Do I need an Internet connection to download Weather info? 
A.   Yes. You must have an Internet connection in order to download 
 C-Weather data. 

Q.  Can I transfer downloaded weather to my Chart Plotter? 
A.   Yes. You will be able to load C-Weather data onto a Memory Card   
 and transfer this information to your chart plotter. 
 NOTE:  C-Weather is a new feature for C-Map and may not be compatible  
 with your chart plotter. Please contact your chart plotter manufacturer for  
 compatibility. 

Q.  How often is the Weather information updated? 
A.   C-Weather data is stored on remote servers and is updated daily at (0900)  
 and (2100), Central European Time.
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Q. How do I download C-Weather?
A.   Click on the C-Weather button on the toolbar           and a dialog box will 
appear.  Click on the area you wish to download (a grid pattern will appear, 

denoting the area to be downloaded).  Once you have 
decided on the area to retrieve weather for, click on the 
DOWNLOAD button in the dialog box. Only one region 
can be downloaded at a time. 

Q.  Is there a cost to download C-Weather? 
A.  No, C-Weather is a complimentary service!

Additional C-Weather info can be accessed in PC-Planner using your 
F1 key > Contents > C-Weather (#11)

NOTES...

_____________________________________________________________
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Jeppesen Marine
133	Falmouth	Road	•	Mashpee,	MA	02649

508.477.8010	•	800.424.2627
October 2008
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